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Measurement of the light center length of automotive 
LED lamps according to IEC 60809:20211 

Application Note, AN RIGO 001, 2022-11-09 

This application note illustrates the measurement of the light center length based on the example of 

an LED signal lamp of type LY5B using a near-field goniophotometer of type RiGO801 - LED. The 

method based on the evaluation of ray data is specified in the IEC 60809:2021 [1] standard. 
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Measurement of ray data with the near-field goniophotometer RiGO801 - LED 

All RiGO801 goniophotometers are based on the near-field measurement principle. A luminance 

measurement camera captures the complete spatial luminance distribution of a light source. From 

these data, ray data and luminous intensity distribution are derived based on the photometric 

fundamental law (see [2], [3], [4], [5], [6]). This measurement procedure is independent of the 

photometric limiting distance and therefore allows small measurement distances and compact 

goniophotometers. 

 

Ray data (also ray file) is a data set of vectors with associated luminous flux components. A 

sufficiently high number of rays accurately represents the complete light source distribution pattern. 

These data are therefore widely used for simulating optical components in a realistic way. 

The goniophotometer type RiGO801 – LED is 
specially designed for the measurement of ray data 
of LEDs and LED modules. The luminance measuring 
camera LMK 6-5 is moved on a circular arc (theta-
axis) around the measuring object mounted on the 
standing rotation axis (phi-axis). 

An example of the measurement of a ray is shown in 
Figure 2. A pixel of the image sensor together with 
the center of the lens defines the starting point 

 , ,x y zP P P  and the direction  , ,x y zn n n  of the 

ray. The luminous flux component   is calculated 
from the luminance of the pixel and the 
corresponding solid angle. 

 

Figure 1: RIGO801 – LED 

The rays from all the luminance images make up the ray data set. Initially, starting points of all rays 

are located on the spherical surface defined by the camera. To facilitate the processing of the rays in 

the optics simulation, the starting points are moved to an enveloping surface around the light source 

(target geometry) using ray tracing (Figure 3). Figure 4 shows a ray data set computed on a thin 

circular disk as a 3D vector field. 
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Figure 2: Measurement of a ray 

 

Figure 3: Raytracing on target geometry. 

The ray data are processed with the free software 
Converter801. In addition to exporting the data to all common 
file formats, various evaluations can be performed, e.g. 
calculation of the center of light or of the photometric center. 

More information is available on our website: 
http://www.technoteam.de/ 

 

Figure 4: Ray dataset 

Measurement of the light center length according to IEC 60809:2021 

Annex K.1 of IEC 60809:2021 describes a method for 
measuring the light center length for LED lamps of types 
Lx3A, Lx3B, Lx4A, Lx4B, Lx5A, Lx5B8), L1A/6 and L1B/6. 

The light center length is calculated from measured ray data. 
The light center is defined as the location where the sum of 
the quadratic distances of the ray vectors is minimum.  

The distances of the rays (index i , starting point p , 

direction r ) to a point c  is defined by  

Figure 5: Light center distance e 
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We are looking for the point c  for which the following relation is valid 

 2min .i

i

d
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 (2) 

The minimization problem is solved by the least squares method [7]. The system of Gaussian normal 

equations results from 

 2 0i

i

d  . (3) 
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In Figure 6, the location of the light center of a Ray data 
set is shown as an example. 

Due to the quadratic evaluation of the distances, outliers 
in the measured data can strongly influence the results of 
the equalization calculation. Therefore, it is necessary to 
eliminate e.g. rays caused by noise during the 
equalization calculation. Furthermore, the luminous flux 
components of the rays must of course be considered as 
weights.  

Figure 6: Rays with light center 

The IEC 60809:2021 specifies a minimum number of 1 million rays. The angular resolution of the 

luminance images on which the ray data measurement is based must be at least 1° x 1°. 

Measurement of the light center length of a LY5B LED signal lamp 

For measuring LED lamps of types Lx3A, Lx3B, Lx4A, Lx4B, Lx5A, Lx5B8, L1A/6 and L1B/6 the 

goniophotometer RiGO801 – LED is very well suited. The following shows how to measure a LY5B LED 

signal lamp with this system. 

Placing the lamp in the goniophotometer 
As shown in Figure 5, the distance e is the distance between the reference plane and the center of 

light. The position of the reference plane and the reference axis in relation to the coordinate system 

of the goniometer — and thus the ray data — must be known exactly. 

The alignment and positioning of the light source is performed using the coordinate system 

superimposed on the camera image. The required reference features of the measured object must, 

of course, be clearly recognizable in the camera image. Here, the influences of depth of field and 

distortion of the lens used as well as perspective distortion must be considered. Capturing the 

reference features of the lamp types listed above directly in the camera image is already more 

challenging here. For convenient measurement with high accuracy, it is therefore recommended to 

use a special reference measurement holder with a suitable lamp base, which is provided with 

suitable markings. 

We had to improvise for the measurement sequence shown here since no special measurement 

socket was available. A lens with a larger field of view of 35 mm and a correspondingly large depth of 

field was used to capture an image of the entire LY5B lamp, including the lamp holder. The reference 

plane was placed exactly in the X/Y plane (Z=0) of the goniometer. The following figures show the 

DUT in the goniometer and the adjustment images from the camera perspective. 
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Figure 7: Position in the goniometer Figure 8: adjustment image — Top View Figure 9: adjustment image — 
Side views 

Measurement parameters 

Angle range and 
measurement trigger: 

Total half space with 1° x 1° angular resolution according to IEC 
60809:2021, Annex K.1 

Stabilization phase: Minimum 30 minutes. Time frame for stability criterion 15 minutes. 
Automatic start when stability criterion of 0.2% (within 12 minutes time 
frame) is reached or after 40 minutes at the latest. 

Measuring time: 0:50 h 

Test voltage: 12 V DC 

Stabilization phase 
During the stabilization phase, the illuminance is continually measured. The stabilization criterion is 

determined from the minimum and maximum illuminance within a selectable time frame. After 

reaching the minimum stabilization time, the measurement is started automatically when the 

selected stability threshold (here 0.2%) is reached. The progression of the stabilization phase (Figure 

10) shows that a constant value of 0.4% is reached from about 25 minutes until the maximum 

stabilization time is reached. 

 

Figure 10: Stabilization phase 
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Measurement results 
The result of the measurement is a TTL file (TechnoTeam luminous intensity distribution) and a TTR 

file with the ray data (see the following chapter). Even though the luminous intensity distribution and 

the luminous flux are not relevant for the determination of the light center length, the results will be 

briefly listed here. The luminous flux was additionally measured at 13.5 V and 9 V to provide a 

statement on compliance with the tolerances. 

Test voltage Luminous flux Set points (LY5B)1 

9 V 136 lm Minimum 55 lm 

12 V 224 lm - 

13.5 V 248 lm 224 lm – 336 lm 

Table 1: Measured luminous fluxes 

A cut of the luminous intensity distribution is shown in Figure 11. 

 

Figure 11: Luminous intensity distribution (cut). 

Preparing the ray data 
The ray data was stored in the TTR file. This file contains the raw data of the ray data measurement, 

which can be converted to various ray data formats with the Converter801 software from 

TechnoTeam [8]. Furthermore, a calculation of the light center is possible. Before that, various 

settings and evaluations have to be made. 

Opening the TTR file 
The TTR file is loaded with menu item File -> Open. An overview of the included measurement 

parameters and measurement results opens. This window will be closed. 

Specifying the target geometry 
As explained before, the equalization calculation with the quadratic evaluation of the distances is 

sensitive to "outliers" in the measured data. Applied to ray data these are rays that are far outside 

the light source, e.g., due to noise or other sources of interference. It is therefore recommended to 

exclude these non-related rays by defining an enveloping surface around the light source. All rays 

                                                           
1 according to Sheet L5/1 R.E.5 [3] (Production light sources) 
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used for the compensation calculation must intersect this enveloping surface. The enveloping surface 

is called the target geometry. 

When defining the target geometry, sufficient space must be left around the real light source 

geometry to avoid excluding relevant rays. The light-emitting surface of the measured lamp can be 

simplified as a flat circular disk with a diameter of 8 mm and a thickness of 2 mm. The light emission 

area is about 3 mm above the x/y plane (see Figure 9). The target geometry parameters are set in the 

Options -> Target geometry menu. As geometry type Cylinder is selected. Clicking the Settings button 

opens the dialog for the geometry parameters (Figure 12). 

 

Figure 12: Geometry parameters 

The radius is specified as 4 mm and the length as 2 mm. The cylinder axis is Z. The displacement of 

the target geometry to the position of the light emitting surface is done with the translation 

parameter Tz = 3 mm. 

To check the parameters, we recommend generating a ray file, e.g. a LightTools .ray file. To do this, 

open the menu item Transform -> LightTools ray file (*.ray). One million rays is sufficient (see Figure 

13). Start the process by clicking the Start button and selecting a file name. 
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  

Figure 13: Generate a ray file. 

At the end of the conversion process, the number of exported rays is compared with the predefined 

number. In this example, 99.92% of the rays were "captured" by the selected target geometry, the 

rest are unwanted rays, which are therefore not included in the target file. The acceptable limit for 

the percentage of excluded rays depends on the measured object or the measurement setup. If a 

light source also emits light from the side and there may be reflections on the circuit board or other 

components that are also measured, the percentage of excluded rays may well be several percent. In 

the case of this type of signal lamps, such effects are not expected, so the percentage of excluded 

rays should be less than 1%. 

In some cases, it may be interesting to research the source of the excluded rays. It is also possible to 

save these rays to a file and transform them to a plane using Raytracing. The illuminance distribution 

of the 0.08% excluded rays is shown in Figure 14. A large part of these rays is caused by reflection at 

two solder joints, the rest is scattered light. 
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Figure 14: origin of the excluded rays (left: Illuminance distribution in logarithmic scale, right: camera adjustment image 
with circular region, diameter 8 mm). 

Embedding the parameters into the TTR file 
The target geometry settings made so far are only stored in the current settings of the Converter 801 

software. We recommend that you include these parameters in the TTR file so that you can refer to 

them later if necessary. The parameters are applied in the Edit mode (File -> Edit). In the first tab 

"Details of measurement", click the button next to "Take global settings" (see Figure 15). When you 

close the dialog, the TTR file is saved. 

  

Figure 15: Transferring the geometry parameters to the TTR file 

Calculation of the light center length 
This algorithm is run from the menu item Tools -> Calculate the center of gravity of rays (see Figure 

16). The Use target geometry ... from TTR source file option is used to transfer the parameters 

embedded in the TTR file. According to IEC 60809:2021, 1 million rays is sufficient. To start the 

calculation, click the Proceed button. 

 

Figure 16: Calculation of the light center 

The result is displayed in the output window. The sought center of light length e is here the Z 

coordinate of the light center. The result is e = 2.996 mm. According to R.E.5 [9], the tolerance is +/- 
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0.3 mm for "Production LED light sources" and +/- 0.15 mm for "Standard LED light sources". 

Tolerances for the similarly calculated x and y coordinates of the light center are not listed in the 

standards. Here they are very close to the symmetry axis of the lamp with -0.02 and -0.12 mm. 

Considering all rays, i.e., also rays measured by reflections and scattered light, the light center length 

is e = 2.999 mm. In this case, the influence would therefore be negligible. 

Considerations on measurement uncertainty 

The tolerances of +/- 0.3 mm and +/- 0.15 mm specified in R.E.5 [9] place high demands on the 

measurement technology and the measurement setup. A desirable measurement uncertainty would 

be 1/10 of that, or 15 µm. Significant contributions to total measurement uncertainty are: 

 Accuracy of positioning in the goniometer (reference plane) 

 Measurement uncertainty of ray data (also includes effects due to lack of maintenance of the 

measuring device). 

 Stray light/reflections 

 Lens resolution 

To estimate the measurement uncertainty of the measurement performed in this Application Note, 

the following parameters are considered. 

 RiGO801 – LED: 

o Tolerance of the coordinate center or the ray coordinates in the center: +/- 10 µm 

o Error of the coordinate system (scaling): < 0.25 % -> for 3 mm = 7.5 µm 

o Resolution of the lens used: 35 µm/pixel 

 Positioning in the goniometer (reference plane): +/- 35 µm 

A simple addition of the maximum tolerances results in approx. +/- 50 µm. A significant factor comes 

from the relatively low resolution of the lens, which leads to a large uncertainty in the positioning of 

the light source, as performed here. 

Therefore, the following steps are recommended for measurements in productive use. 

 Use of a lens with a smaller field of view and thus higher resolution. Das Makro 

Standardobjektiv hat ca. 10 µm / Pixel. 

 Precise measurement acquisition with tools for exact alignment using the macro lens. 

 Coordinate system scaling correction 

 Use reference standard 

Summary 

In this Application note, it was shown how to determine the light center length of an automotive 

signal lamp from ray data in accordance with the requirements of IEC 60809:2021 with little 

measurement effort. Many practical tips were given and possible sources of error in the 

measurement or processing of the ray data were explained.  

The near-field goniophotometer RiGO801 - LED is very well suited for the measurement task. The 

measuring time at a high angular resolution of 1° x 1° is very short due to the continuous on-the-fly 
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measurement and therefore suitable for practical use. The measurement method has already proven 

itself many times in the industry. 

The near-field goniophotometer is also suitable for additional measurements. This way, the luminous 

flux and the luminous intensity distribution are also measured by default. An evaluation of the 

luminance distribution for specific lamp types according to IEC 60809:2021, Annex L.2 is also 

possible. 
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